# Table of Contents

- **Preface**
  - System Requirements ........................................... 3

- **Installation Guide**
  - Pre-Installation Checklist ......................................... 4
    - Installation .......................................................... 4
    - Software Licensing ................................................. 5
    - Terminology and Conventions ................................... 6
    - Contacting Thermo Fisher Scientific ............................ 7
    - Documentation Feedback ......................................... 7
    - Software Overview ............................................... 8

- **Chapter 1** Interface Overview .................................. 9
  - File Tab ...................................................................... 10
  - Image Tab .................................................................... 10
  - Lanes/Bands Tab .......................................................... 10
  - Annotation Tab ............................................................ 10
  - Right-hand Toolbar .................................................... 11
  - Main Image View ........................................................ 11
  - Copy Image .................................................................. 11
  - Image Bench .................................................................. 12
  - Analysis Table ............................................................. 12
  - Keyboard Shortcuts ..................................................... 12

- **Chapter 2** File Tab .................................................. 13
  - Open Images .................................................................. 13
  - Multiple Image Viewing ............................................... 14
  - Close Image .................................................................. 14
  - Save Image ................................................................... 15
  - Image Compatibility ..................................................... 15
  - Image Performance Guidelines ........................................ 16
  - Images Obtained from the myECL Imager ......................... 16
  - Image Information ........................................................ 17
  - Exporting and Generating Reports ................................... 18
    - Export Image ............................................................. 18
    - Export Image as JPEG or TIFF ...................................... 19
    - Show Report ................................................................ 19
    - Image Report Export .................................................. 20
    - Print Report .............................................................. 20

- **Chapter 3** Image Tab ................................................ 21
  - Image Flip .................................................................... 21
  - Image Rotate ............................................................... 22
  - Crop ........................................................................... 23
  - Display Saturation ........................................................ 23
  - Invert .......................................................................... 23
  - Contrast Adjustment ..................................................... 23
Chapter 4 Lanes/Bands Tab

Auto-Adjust Module .................................................. 27
Lanes/Bands Subtab ...................................................... 28
Lanes ................................................................. 29
Bands ................................................................. 30
Regions ............................................................... 30
Background Subtraction .............................................. 31
Molecular Weight Subtab ............................................... 34
Apply MW Markers ..................................................... 35
Settings ................................................................. 36
Molecular Weight Marker Overlay .................................. 37
Overlay Result ........................................................... 38
Quantity Subtab ........................................................ 39
Relative Reference ...................................................... 39
Absolute Reference .................................................... 39

Chapter 5 Annotation Tab .................................................. 41
Text Annotation .......................................................... 41
Line Annotation .......................................................... 42
Arrow Annotation ........................................................ 43
Align Annotations ......................................................... 43

Chapter 6 Right-hand Toolbar ............................................... 44
Right-hand Toolbar — Image Display Functions ................. 44
Right-hand Toolbar — Template Creation ....................... 45
Creating Templates — Copy/Paste Feature ....................... 46
Using Templates ......................................................... 46
Undo/Redo ............................................................... 47
Lane Profile ............................................................. 47
Standard Curve ........................................................ 48

Chapter 7 Analysis Table ..................................................... 49

Chapter 8 Troubleshooting .................................................. 52
Technical Support ........................................................ 52
FAQs ................................................................. 52

Appendix A Getting Started .................................................. 55
Example Workflow ....................................................... 55
Assign Frame, Lanes and Bands ....................................... 56
Annotation ............................................................... 58
Comparing Band Intensity ............................................... 58
Image Report Export ..................................................... 59
Print Report ............................................................. 59
Published By
Thermo Fisher Scientific Inc.
3747 North Meridian Road
Rockford, Illinois USA 61101
Telephone: +1 (815) 968-0747

Copyright
Copyright © 2014 by Thermo Fisher Scientific Inc. All rights reserved.

Portions of this document are protected by trade secrets, copyrights, and/or other proprietary material. Use of the Thermo Scientific™ ImageAnalysis Software product requires a license from Pierce Biotechnology Inc., a subsidiary of Thermo Fisher Scientific Inc., and is entered into in conjunction with the purchase of the software.

Thermo Fisher Scientific Inc. reserves the right to make modifications and additions to the information in this document without notice. No part of this document may be reproduced or transmitted in any form or means, electronic, photographic, mechanical, or otherwise, for any purpose without the express written permission of Thermo Fisher Scientific Inc.

Trademarks
Pierce, eCL, and ImageAnalysis are trademarks or registered trademarks of Thermo Fisher Scientific Inc. (or legal entity Pierce Biotechnology Inc.)

Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation. Other products or company names mentioned in this document may be trademarks or registered trademarks of their respective owners and are treated as such.

All other trademarks are property of Thermo Fisher Scientific Inc. and its subsidiaries.

Software License Terms
CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE COMPLETING THE INSTALLATION OF THE SOFTWARE AND/OR USING EQUIPMENT. BY CLICKING THE “ACCEPT” OPTION, BY USING THE EQUIPMENT, OR BY INSTALLING, COPYING OR OTHERWISE USING THE SOFTWARE, YOU HAVE AGREED THAT THESE TERMS AND CONDITIONS WILL BE BINDING UPON YOU, ANY END USER AND YOUR COMPANY (“Buyer”). Clicking the “accept” option is a symbol of Buyer’s signature and assent to all parts of these terms and conditions. If Buyer does not want to agree, do not take any of the above actions and return both the Equipment and the software to Pierce Biotechnology, Inc., a wholly-owned subsidiary of Thermo Fisher Scientific Inc. at 3747 N. Meridian Road, Rockford, IL 61101 for a refund.

LICENSE TERMS. With respect to any software products incorporated in or forming a part of the Products hereunder, Seller and Buyer intend and agree that such software products are being licensed and not sold, and that the words “purchase”, “sell” or similar or derivative words are understood and agreed to mean “license”, and that the word “Buyer” or similar or derivative words are understood and agreed to mean “licensee”. Notwithstanding anything to the contrary contained herein, Seller or its licensor, as the case may be, retains all rights and interest in software products provided hereunder.

Seller hereby grants to Buyer a royalty-free, non-exclusive, nontransferable license, without power to sublicense, to use software provided hereunder solely for Buyer’s own internal business purposes on the hardware products provided hereunder and to use the related documentation solely for Buyer’s own internal business purposes. This license terminates when Buyer’s lawful possession of the hardware products provided hereunder ceases, unless earlier terminated as provided herein. Buyer agrees to hold in confidence and not to sell, transfer, license, loan or otherwise make available in any form to third parties the software products and related documentation provided hereunder. Buyer may not disassemble, decompile or reverse engineer, copy, modify, enhance or otherwise change or supplement the software products provided hereunder without Seller’s prior written consent. Seller will be entitled to terminate this license if Buyer fails to comply with any term or condition herein. Buyer agrees, upon termination of this license, immediately to return to Seller all software products and related documentation provided hereunder and all copies and portions thereof.

Certain of the software products provided by Seller may be owned by one or more third parties and licensed to Seller. Accordingly, Seller and Buyer agree that such third parties retain ownership of and title to such software products. The warranty and indemnification provisions set forth herein shall not apply to software products owned by third parties and provided hereunder.

LIMITATIONS ON LIABILITY. NOTWITHSTANDING ANYTHING TO THE CONTRARY CONTAINED HEREIN, THE LIABILITY OF SELLER UNDER THESE TERMS AND CONDITIONS (WHETHER BY REASON OF BREACH OF CONTRACT, TORT, INDEMNIFICATION, OR OTHERWISE, BUT EXCLUDING LIABILITY OF SELLER FOR BREACH OF WARRANTY (THE SOLE REMEDY FOR WHICH WILL BE AS PROVIDED UNDER THE WARRANTY SECTION BELOW) WILL NOT EXCEED AN AMOUNT EQUAL TO THE TOTAL PURCHASE PRICE PAID BY BUYER TO SELLER WITH RESPECT TO THE PRODUCT(S) GIVING RISE TO SUCH LIABILITY. NOTWITHSTANDING ANYTHING TO THE CONTRARY CONTAINED HEREIN, IN NO EVENT WILL SELLER BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL OR INCIDENTAL DAMAGES (INCLUDING WITHOUT LIMITATION DAMAGES FOR LOSS OF USE OF FACILITIES OR EQUIPMENT, LOSS OF REVENUE, LOSS OF DATA, LOSS OF PROFITS OR LOSS OF GOODWILL), REGARDLESS OF WHETHER SELLER (a) HAS BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES OR (b) IS NEGLIGENT.
Warranty and Disclaimer of Warranties

Products are warranted to operate or perform substantially in conformance with published Product specifications in effect at the time of sale, as set forth in the Product documentation, specifications and/or accompanying package inserts ("Documentation") and to be free from defects in material and workmanship. SELLER DOES NOT WARRANT THAT THE PRODUCTS ARE ERROR-FREE OR WILL ACCOMPLISH ANY PARTICULAR RESULT. Unless GOODWILL, REGARDLESS OF WHETHER SELLER (a) HAS BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES OR (b) IS NEGLIGENT, otherwise expressly authorized in writing, Products are supplied for research use only. No claim of suitability for use in applications regulated by FDA is made. The warranty provided herein is valid only when used by properly trained individuals. Unless otherwise stated in the Documentation, this warranty is limited to one year from date of shipment when the Product is subjected to normal, proper and intended usage. This warranty does not extend to anyone other than Buyer. NO OTHER WARRANTIES, EXPRESS OR IMPLIED, ARE GRANTED, INCLUDING WITHOUT LIMITATION, IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR ANY PARTICULAR PURPOSE, OR NON-INFRINGEMENT. BUYER'S EXCLUSIVE REMEDY FOR NON-CONFORMING PRODUCTS DURING THE WARRANTY PERIOD IS LIMITED TO REPAIR, REPLACEMENT OF OR REFUND FOR THE NON-CONFORMING PRODUCT(S) AT SELLER'S SOLE OPTION. THERE IS NO OBLIGATION TO REPAIR, REPLACE OR REFUND FOR PRODUCTS AS THE RESULT OF (i) ACCIDENT, DISASTER OR EVENT OF FORCE MAJEURE, (ii) MISUSE, FAULT OR NEGLIGENCE OF OR BY BUYER, (iii) USE OF THE PRODUCTS IN A MANNER FOR WHICH THEY WERE NOT DESIGNED, OR (iv) IMPROPER STORAGE AND HANDLING OF THE PRODUCTS. ANY INSTALLATION, MAINTENANCE, REPAIR, SERVICE, RELOCATION OR ALTERATION TO OR OF, OR OTHER TAMPERING WITH, THE PRODUCTS PERFORMED BY ANY PERSON OR ENTITY OTHER THAN SELLER WITHOUT SELLER'S PRIOR WRITTEN APPROVAL, OR ANY USE OF REPLACEMENT PARTS NOT SUPPLIED BY SELLER, SHALL IMMEDIATELY VOID AND CANCEL ALL WARRANTIES WITH RESPECT TO THE AFFECTED PRODUCTS. THE OBLIGATIONS CREATED BY THIS WARRANTY STATEMENT TO REPAIR OR REPLACE A DEFECTIVE PRODUCT SHALL BE THE SOLE REMEDY OF BUYER IN THE EVENT OF A DEFECTIVE PRODUCT.

EXPORT RESTRICTIONS. Buyer acknowledges that each Product and any related technology, including technical information supplied by Seller or contained in documents (collectively "Items"), is subject to export controls of the U.S. government. The export controls may include, but are not limited to, those of the Export Administration Regulations of the U.S. Department of Commerce (the "EAR"), which may restrict or require licenses for the export of Items from the United States and their re-export from other countries. Buyer will comply with the EAR and all other applicable laws, regulations, laws, treaties, and agreements relating to the export, re-export, and import of any Item. Buyer will not, without first obtaining the required license to do so from the appropriate U.S. government agency; (i) export or re-export any Item, or (ii) export, re-export, distribute or supply any Item to any restricted or embargoed country or to a person or entity whose privilege to participate in exports has been denied or restricted by the U.S. government. Buyer will cooperate fully with Seller in any official or unofficial audit or inspection related to applicable export or import control laws or regulations, and will indemnify and hold Seller harmless from, or in connection with, any violation of this Section by Buyer or its employees, consultants, agents, or customers.
Preface

System Requirements

The Thermo Scientific myImageAnalysis Software requires the following system configurations:

Minimum Requirements

- Operating System: Windows™ 7
- CPU: Pentium® 3, 5,00MHz
- System Memory (RAM): 256MB
- Hard Disk: 400MB free space
- Graphics Card: DirectX™ 9 and 3D capable with 64MB of VRAM
- Screen: 1024 x 768, “16-bit High Color”

Recommended Requirements

- Operating System: Windows 7
- CPU: Pentium 4, 2,4GHz+ or AMD 2400xp+
- System Memory (RAM): 512MB
- Hard Disk: 2GB free space
- Graphics Card: DirectX 9 and 3D capable with 256MB of VRAM
- Screen: 1280 x 1024, “32-bit True Color”

Note This manual is for reference use. Application, button and window appearances may vary depending on system configurations.
Installation Guide

Before you begin the installation, contact your information technology (IT) department concerning the following:

Pre-Installation Checklist

1. Ensure you can log onto the computer with administrative privileges.
2. If installing the software onto a laptop computer, ensure the computer is plugged in.
3. Ensure your computer has a CD drive.

Installation

1. Insert the Thermo Scientific myImageAnalysis Software installation CD. The installation should automatically begin. If autorun does not function correctly, you can start the installation by navigating to the CD and double-clicking “setup.exe”. The myImageAnalysis Software requires the installation of the Microsoft .NET Framework 4.0. If Microsoft .NET Framework Client Profile version 4.0 has not been previously installed, you will be asked to install this component. Click **Install** to continue; click **Cancel** to exit the program without installing.
2. The Microsoft .NET Framework 4.0 is installed. If the User Account Control screen appears, click the **Yes** button to allow the software installation.
3. After .NET Framework installation, the Welcome to the myImageAnalysis Setup Wizard window appears. Click **Next** to continue software installation or **Cancel** to abort installation.
4. The License Agreement screen appears. After reading the license agreement, select the **I Agree** button to accept the license agreement terms and then click the **Next** button. If you do not accept the terms of the agreement, click the **I Do Not Agree** button to exit the program without installing.
5. The myImageAnalysis User Manual screen appears. Ensure the box is checked for the user manual to automatically open after software installation is complete. Click **Next** to continue installation.
6. The Select Installation Folder screen appears. The default installation folder is C:\Program Files\Thermo\myImageAnalysis. To change the location, click the **Browse...** button. To view the amount of space the application will take up on your hard drive, click the **Disk Cost** button. If there are multiple users on this computer, choose the “Everyone” option to grant all users access to this software; otherwise, choose the “Just me” option to allow only the current user access to the program. Click the **Next** button to continue.
7. The Confirm Installation screen appears. To begin the installation, click the **Next** button. To cancel the installation, click the **Cancel** button.
8. The Installing myImageAnalysis screen appears showing the progress of the installation. To stop the installation, click the **Cancel** button; otherwise, wait for the installation to complete.
9. If the User Account Control screen appears, click the Yes button to allow the software installation.

10. myImageAnalysis Software installation begins.

11. When the Installation Complete screen appears, click the Close button. This step completes the installation of the myImageAnalysis Software.

12. If the view User Manual box was checked during installation, the user manual opens with Adobe™ Reader™ Software.

13. A desktop shortcut icon is automatically created during the software installation. To launch the myImageAnalysis Software, double-click on the shortcut icon.

**Software Licensing**

A license file is required for long-term use of the myImageAnalysis Software. The program can be activated for a 30-day trial period by selecting the Try It button in the About myImageAnalysis Software window that appears after double-clicking the desktop icon for the first time. Follow these steps to obtain a license and activate the software:

1. Email the following information to pierce.ts@thermofisher.com:
   - Computer code (select the About myImageAnalysis Software button to obtain this information)
   - Name
   - Institution name, department and address
   - Phone number

   **Note** Technical Support may need to request additional information.

2. After receiving the license file, save it to the computer. Launch the myImageAnalysis Software and select the About myImageAnalysis Software button.

3. Select Browse to locate the saved license file. Choose the license file and select Open. Once the license file is detected, the software is activated.
Terminology and Conventions

This guide assumes that you have a basic knowledge of computers using Windows operating systems and experience working with windows, menus, commands, buttons, tabs, dialog boxes and other Windows elements. If you are unfamiliar with these terms, please refer to Windows documentation.

Throughout this guide, certain terminology and conventions are used consistently as described below:

**Terminology**

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Place the mouse pointer over an item; depress and release the primary mouse button (usually the left button) in one quick motion.</td>
</tr>
<tr>
<td>Double-click</td>
<td>Place the mouse pointer over an item; depress and release the primary mouse button twice in quick succession.</td>
</tr>
<tr>
<td>Drag</td>
<td>Place the mouse pointer over an item; depress and hold down the left mouse button, move the pointer (and the object) to some target location, then release the mouse button.</td>
</tr>
<tr>
<td>Press</td>
<td>Push and release a key on the keyboard (e.g., press the Tab key).</td>
</tr>
<tr>
<td>Shift Ctrl Alt</td>
<td>When any of these terms appear before any of the above terms, it means to hold down the specified keyboard key while taking the hyphenated action. Thus, Shift-click means to hold down the Shift key while clicking an item.</td>
</tr>
</tbody>
</table>

**Conventions**

- **Menu names, menu items, buttons and options** appear in **bold** type (e.g., click the Next button).
- **Window titles, menu names, option names and dialog box names** begin with **uppercase letters** (e.g., “The License Agreement screen appears”).
Contacting Thermo Fisher Scientific

If you have a technical question not answered using this manual, please contact Technical Support:

- **U.S. Customers:** 1-800-874-3723  
  FAX: 1-800-842-5007
- **International Customers:** +1 815-968-0747  
  FAX: 1-815-968-4736

Technical Support email: pierce.ts@thermofisher.com

For more information about the Thermo Scientific™ Protein Biology product line, please visit our website: thermoscience.com/pierce

Thermo Fisher Scientific  
3747 North Meridian Road  
Rockford, Illinois USA 61101  
U.S. Toll-free: (800) 874-3723  
Main: (815) 968-0747  
Fax: (800) 842-5007  
E-mail: pierce.ts@thermofisher.com

Before contacting Technical Support for service or support, it is helpful if you are prepared to answer the following questions:

- What were you doing when the problem occurred?
- Can you reproduce the problem?
- Did you try to solve the problem? If so, what steps did you take and what did you observe?
- Which error messages, if any, appeared?

Having these answers will help us provide you with a solution as quickly as possible.

Documentation Feedback

We are committed to providing you with the highest quality product documentation and online help. We welcome comments and suggestions for improvement. Before emailing your feedback to us, it is helpful if you include the following information:

- **Document title, part number and page number.** The part number can be found in the bottom left corner of the manual’s back cover.
- **Comments** – Please feel free to comment on the organization, clarity, content, utility, index, search capabilities, or physical characteristics such as the manual size, binding, fonts, etc.
- **Suggestions** – Please provide suggestions, if possible, on how to correct or improve the documentation or online help.

Email feedback to: pierce.ts@thermofisher.com and indicate “Documentation Feedback” in the email subject field.
Software Overview

myImageAnalysis Software provides a suite of tools for analysis of digital images of electrophoresis gels and Western blots. This software performs densitometry, molecular weight determination, relative and absolute quantitation, and purity calculations along with the ability to adjust (e.g., contrast, rotation, crop) and annotate images. myImageAnalysis Software contains new features that offer analysis improvements over other available software programs:

- Powerful automatic analysis module that results in more consistent and accurate lanes and bands detection, including real-time band detection sensitivity adjustment.
- Band addition by mouse click results in automatic integration of the intensity peak, eliminating the need to manually adjust the band boundaries.
- Proprietary molecular weight overlay feature whereby a colorimetric molecular weight marker can be overlaid onto a chemiluminescent image for molecular weight determination. The underlying chemiluminescent densitometry data are not compromised. Accurate, convenient molecular weight analysis using standard colorimetric markers has never before been achieved.
- Versatile, open platform that can accept the standard image file types (i.e., TIFF, JPEG, PNG, GIF, BMP files).
- Prepare analysis reports that can be directly exported to Microsoft Word, Excel™ and PowerPoint™ Software, and as a PDF opened with Adobe Reader Software.
Chapter 1

Interface Overview

myImageAnalysis Software is organized into the following areas:

• Main tabs containing the File, Image, Lanes/Bands and Annotation functions. Each tab contains a function ribbon.

• Right-hand Toolbar
• Main Image View
• Image Bench
• Analysis Table

Functions included in each of the main tabs are activated by selecting buttons in the function ribbon. Functions are active only when their corresponding tab has been activated. Active buttons are easily identified and described by tooltips when the cursor is placed or hovered over the function button.
**File Tab**

The function ribbon under the File tab contains the file management functions, including Open Images, Save Image, Close Image, Image Information, Export Image and Show Report.

![File Tab Image](image1)

**Image Tab**

The Image tab contains functions for adjusting the image, including Rotate, Flip, Crop, Display Saturation, Invert, Contrast Adjustment, Histogram, False Color and Enhancement filters.

![Image Tab Image](image2)

**Lanes/Bands Tab**

Displays all of the image analysis functions, including Auto-Analyze for lanes and bands, Resize and Move lanes and bands, manual addition or deletion of lanes, bands or manual regions, and background subtraction tools. Additional subtabs in the Lanes/Bands tab contain Molecular Weight determination and Quantity tools.

![Lanes/Bands Tab Image](image3)

**Annotation Tab**

Includes ability to Create Text, Lines and Arrows to label the image for reporting or publication.

![Annotation Tab Image](image4)
Right-hand Toolbar

Contains basic software functions, which are accessible regardless of the selected main tab. Functions include image display tools, such as **Zoom In/Out**, **Contrast Adjustment** and **Show/Hide Tools** for the image, lands/bands/regions, or annotations. Also included are **Object Selection Tools** for creation and loading of analysis templates and the editing functions **Copy**, **Paste**, **Undo** and **Redo**. **Lane Profile** and **MW Curve** display are located here along with a real-time status bar describing the x- and y-coordinates and pixel intensity at the cursor location. The image rotation angle is displayed below the cursor status.

Main Image View

Opened and selected images are displayed in the **Main Image View**; this is the primary workspace for image analysis.

Copy Image

Copy the displayed image to the clipboard using the **CTRL+C** keyboard shortcut for pasting into another program using **CTRL+V**. Contrast adjustments, annotations and lanes/bands/regions are visible on the pasted image. Annotations and lanes/bands/regions hidden using the **Show/Hide Tools** on the **Right-hand Toolbar** do not appear on the pasted image.
Image Bench

The *Image Bench* displays and holds opened images for easy viewing and allows access to loaded images. The *Image Bench* can be expanded or collapsed to increase the size of the functional space in the *Main Image View* and for display of image thumbnails.

![Image Bench collapsed](image)

![Image Bench expanded](image)

Analysis Table

The real-time *Analysis Table* displays all of the image analysis information created during image analysis, including pixel intensity and density, background subtracted data, relative front (Rf), molecular weight (MW), relative and absolute quantities, and band purity. The *Analysis Table* can be expanded or collapsed for viewing and for increasing the *Main Image View* workspace.

![Analysis Table expanded](image)

Keyboard Shortcuts

- **Arrow keys** – moves templates up, down, left or right
- **CTRL+C** – copies the currently displayed image to the clipboard for pasting into another program; copies objects selected with the **Object Selection Tool** to the clipboard
- **CTRL+O** – open image
- **CTRL+P** – open Print Preview window
- **CTRL+S** – save selected image
- **CTRL+V** – paste objects from the clipboard
- **CTRL+W** – close image
- **CTRL+Y** – redo
- **CTRL+Z** – undo
- **CTRL+Click** – selects multiple annotation objects for alignment
- **Delete** – deletes selected lane frame, lanes, bands and regions
- **F1** – opens help file
- **Shift+Click** – selects multiple image files to open
- **Shift+Enter** – starts new text line in annotation object
Chapter 2

File Tab

Open Images

Select the **Open Images** button to select an image for analysis. In the Open window, select the location and the image file type to open. To open multiple images simultaneously from the Open window, press **CTRL** while selecting the images with the mouse button. **CTRL+O** keyboard shortcut can also be used for opening image files.

Opened images appear in the **Image Bench** as the image file name. When the **Image Bench** is expanded, images open as image thumbnails. The **Image Bench** can be expanded by selecting the **double up arrows**.

Image Bench collapsed

![Image Bench collapsed]

Image Bench expanded

![Image Bench expanded]
Multiple Image Viewing

Multiple images can be displayed simultaneously by selecting images in the Image Bench while holding the CTRL or Shift key on the keyboard. If multiple images are placed in the Image Bench, select the left and right arrows on the bench to scroll for the additional images. Image analysis can be performed only one image at a time.

Close Image

Select the Close Image button to close the selected image. Alternatively, close images by selecting the small X icon to the left of each image. If the image is not modified, it closes without an image save prompt. If the image is modified using any of the functions in the Image, Lanes/Bands or Annotations tabs, a Save window appears. CTRL+W can also be used to close the selected image.
Save Image

Save Image saves changes made to the image using functions in the Lanes/Bands tab or Annotations tab and all of the analysis information for the image. CTRL+S can also be used to save the selected image.

Image Compatibility

myImageAnalysis Software is compatible with .bmp, .jpg, .tif, .png and .gif image types (Table 2-1); however, optimal performance is achieved with the 16-bit grayscale TIFF file format at 200-400 ppi (pixels per inch). Images created at resolutions greater than 600 ppi show a marked decrease in image analysis performance. Thermo Scientific™ myECL™ imager image files are 16-bit grayscale TIFF files at 300 ppi resolution; these files are ideal for use with the myImageAnalysis Software. Save images obtained from document scanners as 16-bit grayscale or color TIFF files at 200-400 ppi. TIFF images are preferred over JPEG images because JPEG compression results in the loss of some image information. Images from other image documentation systems or imagers can be exported and saved in TIFF format for use in the myImageAnalysis Software.

Table 2-1. File types compatible with Thermo Scientific myImageAnalysis Software.

<table>
<thead>
<tr>
<th>Format</th>
<th>Image Type</th>
<th>Compatible</th>
<th>Resolution (ppi)</th>
</tr>
</thead>
<tbody>
<tr>
<td>JPEG (.jpg, jpeg)</td>
<td>8-bit grayscale</td>
<td>Yes</td>
<td>200-800</td>
</tr>
<tr>
<td>JPEG (.jpg, jpeg)</td>
<td>24-bit color</td>
<td>Yes</td>
<td>200-800</td>
</tr>
<tr>
<td>JPEG 2000 (.jp2)</td>
<td>--------------</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TIFF (.tif, .tiff)</td>
<td>8-bit grayscale</td>
<td>Yes</td>
<td>200-800</td>
</tr>
<tr>
<td>TIFF (.tif, .tiff)</td>
<td>16-bit grayscale</td>
<td>Yes</td>
<td>200-800</td>
</tr>
<tr>
<td>TIFF (.tif, .tiff)</td>
<td>24-bit color</td>
<td>Yes</td>
<td>200-800</td>
</tr>
<tr>
<td>PNG (.png)</td>
<td>16-bit grayscale</td>
<td>Yes</td>
<td>300</td>
</tr>
<tr>
<td>GIF (.gif)</td>
<td>16-bit grayscale</td>
<td>Yes</td>
<td>300</td>
</tr>
<tr>
<td>BMP (.bmp)</td>
<td>256-color bitmap</td>
<td>Yes</td>
<td>300</td>
</tr>
<tr>
<td>BMP (.bmp)</td>
<td>24-bit bitmap</td>
<td>Yes</td>
<td>300</td>
</tr>
<tr>
<td>BMP (.bmp)</td>
<td>16-color bitmap</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>
**Image Performance Guidelines**

- **16-bit grayscale TIFF at 200-400 ppi resolution is the optimum file type for image analysis.**

- Grayscale images are preferred over color images (RGB).

- Analysis results with the TIFF format are optimal; PNG, JPG, BMP and GIF images can also be analyzed. Image file types, such as TIFF and PNG file formats, do not lose image information when they are created and, therefore, produce the most accurate results. Conversely, avoid JPG and GIF formats for the most accurate analysis of the image, because these image types lose image information when they are created and re-saved.

- Images between 600-800 ppi show marked reduction in software performance.

- Images with > 800 ppi are incompatible in any format.

**Images Obtained from the Thermo Scientific myECL Imager**

myImageAnalysis Software was designed to work seamlessly with images obtained from the myECL Imager. Images created by the myECL Imager are 16-bit grayscale 300 ppi TIFF images (Table 2-2).

<table>
<thead>
<tr>
<th>Binning</th>
<th>Size (kb)</th>
<th>PPI (pixels/inch)</th>
<th>Pixel × Pixel</th>
<th>Image Size (inches × inches)</th>
<th>Image Size (mm × mm)</th>
<th>Image Size (µm × µm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 × 1</td>
<td>8197</td>
<td>300</td>
<td>2048 × 2048</td>
<td>6.8 × 6.8</td>
<td>173.4 × 173.4</td>
<td>84.7 × 84.7</td>
</tr>
<tr>
<td>2 × 2</td>
<td>2050</td>
<td>300</td>
<td>1024 × 1024</td>
<td>3.4 × 3.4</td>
<td>86.7 × 86.7</td>
<td>84.7 × 84.7</td>
</tr>
<tr>
<td>3 × 3†</td>
<td>910</td>
<td>300</td>
<td>682 × 682</td>
<td>2.3 × 2.3</td>
<td>57.7 × 57.7</td>
<td>84.7 × 84.7</td>
</tr>
<tr>
<td>4 × 4</td>
<td>513</td>
<td>300</td>
<td>512 × 512</td>
<td>1.7 × 1.7</td>
<td>43.3 × 43.3</td>
<td>84.7 × 84.7</td>
</tr>
<tr>
<td>8 × 8</td>
<td>129</td>
<td>300</td>
<td>256 × 256</td>
<td>0.9 × 0.9</td>
<td>21.7 × 21.7</td>
<td>84.7 × 84.7</td>
</tr>
</tbody>
</table>

† myECL Imager default setting

Table 2-2. Binning specifications for sensitivity settings. Table 2-1.
**Image Information**

All images obtained from the myECL Imager also include an .xml file, which contains imagespecific information, such as date, time and exposure time of the captured image. When an image obtained from the myECL Imager is opened in the myImageAnalysis Software, the software searches in the same location of the image file for the .xml file with the same file name. The .xml file contents can be viewed by selection of the **Image Information** button. When an .xml file is found with the same file name as the image file, the **Image Information** button becomes active. In order for the .xml file to be viewed concurrently with the image, the .xml file needs to have the same file name.

![Image Information](image.png)
Exporting and Generating Reports

myImageAnalysis Software has multiple methods for generating image reports. Images and objects or text created in the image under the Annotations tab can be directly exported into Microsoft Word and Microsoft PowerPoint Software. Once the Image Report is generated, the report can be edited using any of the functions available in Word and PowerPoint Software.

**Note** Export to Word or PowerPoint Software in myImageAnalysis Software works only on computers with installed compatible versions of Word or PowerPoint Software.

**Compatibility:**
- Word – Version 2007 and newer*
- Excel – Version 2007 and newer*
- PowerPoint – Version 2007 and newer*

**Note** If the Microsoft Office Compatibility Pack is installed, Version 2003 software can be used. See the Microsoft Compatibility Pack Installation Section on pg 54.

Export Image

1. In the **File** tab, select the **Word** or **PowerPoint** icon under the Export Image heading. Selecting either of these icons opens a Save As window.
2. Select the save location for the file and type a file name.
3. Select **OK** and the Word or PowerPoint file is automatically created and saved in the chosen location.
4. The Word or PowerPoint program will automatically open and display the created file.

The created image report file contains the following information:

- Image file name
- Display of image file
- Creation date: Date image file was created or modified. Changing the file name will not alter the creation date.
- User name: The user login name is displayed.
- Image area: The image height (y-dimension) and width (x-dimension) in millimeters (mm).
- Image pixels: The number of pixels in the x and y dimension in the image.
- Pixel size: Size of the pixels in the image in micrometers (μm).

If available, the corresponding image information .xml file will also display in the Image Report.
Export Image as JPEG or TIFF

1. In the File tab, select the JPEG/TIFF icon under the Export Image heading, which opens a Save As window.
2. Select the save location for the file and type a file name.
3. Choose the file type to save as: 16-bit TIFF, 8-bit TIFF or JPEG.
4. Select OK and the JPEG or TIFF file is automatically created and saved in the chosen location.

Note Export Image saves any image modifications made using functions in the Image tab. Export Image is useful for preparing the image for viewing or desktop publishing. Exported image files should not be used for densitometry analysis because the pixel information is permanently changed.

Show Report

Image Reports can be created, viewed, printed and exported to Word, PowerPoint, Excel or PDF formats by selecting the Show Report button in the File tab.

Selecting the Show Report button displays the generated Image Report, which consists of:

- Image file name
- Display of image file
- Creation date: Date image file was created or modified. Changing the file name does not alter the creation date.
- User name: The user login name is displayed.
- Image area: The image height (y-dimension) and width (x-dimension) in millimeters (mm).
- Image pixels: The number of pixels in the x and y dimension of the image.
- Pixel size: Size of the pixels in the image in micrometers (μm).
- Analysis Table: If any analysis was performed in the Lanes/Bands tab, the information found in the Analysis Table is displayed.
- Lane Profile: The lane profiles of each lane can be displayed in the report by selecting the Lane Profile box in the File tab before selecting Show Report. Lane profiles are created in the Lanes/Bands tab when lanes and bands are assigned to an image.
Image Report Export

Image Reports containing analysis information can be exported to Word, PowerPoint, Excel and PDF formats.

1. Select **Show Report** under the **File** tab and select the **Word**, **PowerPoint** or **PDF** icon in the **Show Report** window.

   **Note** Adobe Reader software must be installed to view PDF files. For export to Excel software, select the **Export Analysis** button (export to Excel software does not export the image or image information). Selecting these options opens a Save As window.

![Image Report Export Icons](image)

   **Note** Export to Excel software works only on computers with Excel version 2003 or newer.

2. Select the save location for the file and type a file name.

3. Select **OK** and the Word, PowerPoint, Excel or PDF file is automatically created and saved in the chosen location. The appropriate application automatically opens and displays the created file.

Print Report

To print the Image Report, select the **Print Report** option in the **Show Report** window.

![Print Report](image)

To print only the image, select the **Print Main Image** button in the **Show Report** window.

![Print Main Image](image)

Selecting **Print Report** or **Print Main Image** opens a Print Preview window where print options are available. The keyboard shortcut, **CTRL+P**, also opens the Print Preview window at any time.
Chapter 3

Image Tab

Image Flip
Images can be flipped on a vertical or horizontal axis by selecting Flip vertical or Flip horizontal.

![Original Image](image1)

![Original Image - Flipped horizontal](image2)

![Original Image - Flipped vertical](image3)
Image Rotate

Image rotation is a useful function if the image was not aligned accurately during image acquisition. **Free rotate** can be used to align the bands horizontally for accurate lane and band analysis and molecular weight or Rf calculations. Image rotation is most effective when performed before any of the functions in the Lanes/Bands tab.

1. Open an image by selecting **Open Image**, under the **File** tab.
2. Under the **Image** tab, select **Free rotate**.

**Note**  **Free rotate** deletes all existing annotations, regions, lanes and bands; select **OK** to continue.

3. Select **OK**, a crosshair appears over the image with an arrow designating the top of the image. The image rotation angle appears at the top left corner of the image.

4. Select any location on the image and align the horizontal line of the crosshair with the bands in the image. The top arrow designates where the top of the image will be after image rotation.

5. Select **OK** to apply the image rotation.

Image rotation in 90° increments can be performed by selecting **Rotate 90°** for clockwise rotation and **Rotate -90°** for counter-clockwise rotation. The applied image rotation angle appears at the bottom of the **Right-hand Toolbar**.
**Crop**

*Crop* can be used to eliminate unwanted area from an image in order to display only the area of interest.

1. Open an image.
2. Choose the *Image* tab and select *Crop*.
3. Create an area of interest on the image by click and drag.
4. Select **OK** to apply crop area.

**Display Saturation**

*Display Saturation* highlights saturated pixels with a false-color red. Saturated pixels are defined as exceeding the gray level pixel intensity range (65,535 for 16-bit images, 4,095 for 12-bit and 255 for 8-bit images) in the selected image. *Display Saturation* is enabled by selecting the *Display Saturation* button. A checkmark shows the function has been activated and remains activated until the button has been de-selected. Any contrast adjustment of the image disables *Display Saturation*. To restore *Display Saturation* function, the image contrast needs to be reset to the image's original contrast setting. To reset to the original contrast setting, select **Auto Adjust** twice.

**Invert**

*Invert* reverses the designation of image pixels from white to black or vice versa. This function reverses image display from a dark background with light objects to dark objects on a light background. *Invert* is beneficial for viewing chemiluminescent images with very faint bands or low contrast. Selecting the *Invert* button again returns the image to its original state.

**Contrast Adjustment**

*Contrast Adjustment* improves visualization of an image. Contrast adjustments are displayed in real-time and performed by selecting and sliding the **Black**, **White** or **Gamma** slider bars located in the *Image* tab or *Right-hand Toolbar*. Additionally, contrast settings can be manually entered by selecting the numbers located on the top right side of the slider bars and typing in the desired contrast settings.

The default contrast for all images is Black = 0 (16-, 12- and 8-bit); White = 65,535 (16-bit), 4,095 (12-bit) or 255 (8-bit); and Gamma = 1. The contrast levels are automatically determined based on the image type. The white level contrast determines which pixel intensities are displayed at the maximum grayscale (white) or color. Black level contrast determines which pixel intensities...
are displayed at the minimum grayscale (black). The gamma setting changes the linearity of image brightness; adjusting gamma expands or compresses the contrast range at the black or white ends of the intensity scale. A Gamma = 1 sets the image to linear pixel intensity, which displays the image as the camera or scanner captured it.

**Note** Contrast adjustments change only the visualization of the image; quantitative data and pixel intensities remain unchanged.

### Auto Adjust

The **Auto Adjust** function automatically selects an optimal contrast adjustment for best viewing. This feature is useful for visualizing chemiluminescent images with short exposure times or weak band intensities. Selecting **Auto Adjust** twice reverts the contrast adjustments to the default contrast setting.

![Auto Adjust](image)

### Histogram

The histogram is a graphical representation of grayscale intensity, which is the proportion of image pixels with certain grayscale intensity. The vertical axis represents the number of pixels and the horizontal axis represents the pixel intensity (black on the left and white on the right). Images with a dark background containing light objects have a majority of the pixel intensities shifted to the black range of the histogram. Likewise, images with a light background containing dark objects have a majority of the pixel intensities shifted to the white. The display of the histogram can be changed by selecting **Log** or **Linear** in the histogram.

**Note** Histogram displays the pixel information from the original image. Any pixel modification functions such as **Crop**, **Despeckle**, **Noise Reduction** and **Sharpen Image** result in a change in the pixel histogram display.
**False Color**

The ImageAnalysis Software can apply 14 color displays to any image. The color displays improve visibility by replacing the colors of each pixel; however, the false colors do not change the original data. False-color displays can be added to an image by selecting the small arrow located in the histogram and the appropriate color display. Once a color display has been added to an image, the **up** and **down** arrows can be used to change from one color display to another.

![False Color Display](image)

**Enhancements**

Image improvements can be performed using any of the four supplied enhancement filters.

1. **Grayscale** filter – Displays RGB (color) images as grayscale. This filter does not modify the pixel intensities.
2. **Sharpen Image** filter – Increases image sharpness or edge enhancement. This filter can modify pixel intensities.
3. **Despeckle** filter – An image-smoothing filter, it removes stray pixels or speckles with intensities that have significantly higher pixel intensity than the surrounding pixels. Smoothing level of the pixels is based on a 1 to 20 scale with a value of 20 resulting in maximum smoothing. This filter can modify pixel intensities.
4. **Noise Reduction** filter – An image-smoothing filter, it assigns new median pixel intensity to those pixels that differ significantly in intensity to neighboring pixels. This filter can modify pixel intensities.

To apply an enhancement filter, select one of the filters from the **Enhancements** drop-down menu and select **Apply Changes**. **Sharpen** and **Despeckle** can be applied at levels from 1 to 20.

**Right-hand Toolbar – Image Display Functions**

In addition to the functions in the **Image** tab used for image display, there are image display functions located in the **Right-hand Toolbar**.

- **Hand Tool** – The hand tool can be used to “grab” and move the image.
- **Fit Image to Screen** – Images not fitting in the **Main Image View** can be scaled to fit using this function. **Fit Image to Screen** can also be used to undo any image resizing done using the **Zoom In** and **Zoom Out** functions.
• **Zoom In / Zoom Out** – Select these functions to increase or decrease the size of the image in the **Main Image View**.

• **Black / White / Gamma slider bars** – See **Contrast Adjustment**.

• **Show / Hide Image** – Hides the image from the **Main Image View** in order to visualize the lanes, bands, annotations or regions.

• **Show / Hide Lanes, Bands and Regions** – Hides any lanes, bands or regions on an image. This function does not remove the lanes, bands or regions.

• **Show / Hide Annotations** – Hides annotations that have been added to an image. This function does not remove the annotations.

• **Cursor Status** – Displays real time x- and y-coordinates and the pixel intensity for the corresponding cursor location.

• **Image Rotation Angle** – Displays the rotation angle applied to the image.
Chapter 4

Lanes/Bands Tab

Auto-Analyze Module

ImageAnalysis Software can automatically identify lanes and bands using the Auto-Analyze module. Auto-Analyze is functional for the full image or a specific region of the image.

**Note** Adjusting image contrast can enhance the software’s ability to detect lanes and bands. Detection is performed on a virtual image displayed on screen; therefore, contrast adjustment affects auto detection. Pixel intensities are determined from the original image and are unaffected by contrast adjustment. Although the original data is unaffected, the area of an identified band is altered by contrast adjustment, which influences the reported pixel intensity. Use Lane Profile to further refine band boundaries.

1. To specify a region for analysis, select the Analysis Frame button. Click and drag to create an Analysis Frame (depicted as a yellow box). An analysis frame is not required; however, designation of an Analysis Frame may improve auto-analysis results. It is recommended to use an Analysis Frame for chemiluminescent images. To redraw the analysis frame, select the Analysis Frame button and create a new one.

2. Select the type of region to analyze for:
   a. Check the Find Lanes box to find lanes only.
   b. Check the Find Bands box to find bands only in previously created lanes.
   c. Check the Find Lanes and Find Bands boxes to find both lanes and bands automatically.

   **Note** Lanes are required for the automatic detection of bands.

3. Verify the background designation is correct:

   - **Black Background** for images with white objects on black background and
   - **White Background** for images with black objects on white background.
4. Select Run.
   
   **Note** Selecting Run on an image with previously identified lanes and/or bands clears existing results and restarts analysis.

5. The Sensitivity tool appears when the Find Bands box is checked. Choose the band detection sensitivity level using the preset buttons, or slider bar or by typing a value in the percentage box.

   a. **Low** – Sets band detection at a low level (25%) for images with prominent bands. Faint bands are not detected with this setting.

   b. **Medium** – Sets band detection at a moderate level (50%).

   c. **High** – Sets band detection at a high level (85%) for images with faint bands. Irrelevant bands can be deleted with the Delete Bands button.

   d. **Custom** – Adjust the band detection sensitivity with the slider bar to identify all bands of interest (0-100%).

   **Note** Uncheck the Preview box to disengage previewing the results of altering the band detection sensitivity level.

6. Select **OK** to accept lane/band identification or **Cancel** to return to the image without lane/band identification results.

7. If an analysis frame was used, it appears yellow. The identified lane frame is orange.

**Lanes/Bands Subtab**

**Lane Frame**

The lane frame is depicted as an orange box framing the lanes on the image.

**Note** To delete the lane frame, select the Object Selection Tool on the Right-hand Toolbar, click on the lane frame and push the Delete key on the keyboard. The lane frame and bands can be copied from image to image or saved as a template via the Right-hand Toolbar.

- **Resize lane frame** – Adjust the lane frame size by selecting this button and dragging the handles in the corners of the frame to fit your gel image.

- **Skew lane frame** – Adjust the orientation of all lanes without altering the lane widths. Select this button and drag the lane frame corner handles independently, applying an angle to the frame.

- **Move lane frame** – Select this button to click and drag the lane frame to the optimal location.
Lanes

The functions available in this section of the software are for manually adding, deleting and adjusting lanes on an image. Lanes are numbered from left to right starting with 1. Lanes can be selected by clicking inside the lane. The perimeter of a selected lane appears blue and the corresponding Analysis Table data is displayed on screen.

Note Lanes may be deleted with the Delete lane button or by pushing the Delete key on the keyboard. The lane frame can be copied from image to image or saved as a template via the Right-hand Toolbar.

Add multiple lanes – Use the up and down arrows to indicate number of lanes to add and select Go. The number of lanes entered in the box are created on the image. The resulting lane frame can be adjusted to fit the image with Resize lane frame, Skew lane frame and Move lane frame.

Note Select a region for multiple lane addition with Analysis Frame, indicate the number of lanes to add to the region, and select Go. The indicated number of lanes are added to the designated analysis region, which can minimize necessary lane adjustments.

Add lane – Add a lane to the lane frame by selecting this button and clicking inside the lane frame. The lane is added with the mouse click point as the center of the lane width. Adding a lane automatically renumbers the lanes in the lane frame.

Delete lane – Delete a lane from the lane frame by selecting this button and clicking in the boundary of the lane to be removed. Deleting a lane automatically renumbers the lanes in the lane frame and also deletes any identified bands in that lane.

Note Lanes can also be deleted by selection with the mouse and then pushing the Delete key on the keyboard.

Move lane – Select this button to click and drag a lane to the optimal location. Moving a lane deletes any identified bands in that lane. Bands can be identified in the repositioned lane with Add band or the Auto-Analyze module with only Find Bands checked, which reanalyzes bands for all lanes.

Note Lanes cannot be dragged outside of the lane frame; however, lanes can be dragged to overlap with other lanes.

Resize lane – Click a lane to select it and then select this button to resize that lane to fit the image. Two handles appear on the right and left edges of the lane. Click and drag these handles to expand or contract the lane width.

Note Lanes cannot be resized beyond the boundaries of the lane frame. The outside lanes may need to be first moved toward the center of the lane frame, and then the width can be expanded.

Skew lane – Click a lane to select it and then select this button to skew that lane. Seven handles appear in the center of the lane. Click and drag these handles to skew the lane perimeter to fit the image. Each handle skews independently, allowing simultaneous skewing in multiple directions.

Smiling correction – To correct for “smiling” or “frowning,” select this button, then click and drag the handles on the top or bottom of the lane frame to the optimal location. These correction handles can be dragged vertically and horizontally to adjust for uneven smiling/frowning effects.

Note If smiling correction is applied after identification of bands, any bands outside of the final lane frame are deleted.
Bands
Functions in this section are for manually adding, deleting and adjusting bands within lanes. Bands are numbered starting with the topmost band as 1. Bands can be selected by clicking inside the band. The perimeter of a selected band appears yellow and the corresponding Analysis Table row is highlighted and displayed on screen.

Note Bands may be deleted with the Delete band button or by pushing Delete on the keyboard. The lane frame and bands can be copied from image to image or saved as a template via the Right-hand Toolbar.

Add band – Add a band to a lane by selecting this button and clicking the band location inside the lane perimeter. The software automatically integrates the intensity at the site of band addition. Adding a band automatically renumbers the remaining bands in that lane.

Delete band – Delete a band from a lane by selecting this button and clicking in the boundary of the band to be removed. Deleting a band automatically renumbers the remaining bands in that lane.

Note Bands can also be deleted by selection with the mouse and then pushing Delete on the keyboard.

Move band – Select this button to click and drag a band to the optimal location.

Note Bands cannot be dragged outside of the lane perimeter; however, bands can be dragged to overlap with other bands. Moving a band retains the band’s area; to refine band boundaries use Resize band or Lane Profile.

Resize band – Click a band to select it and then select this button to resize that band to fit the image. Two handles appear on the top and bottom edges of the band. Click and drag these handles to expand or contract the band height. Lane Profile can be used to further refine band boundaries.

Select multiple bands – Select this button and then click on different bands to select them. This feature is used to select multiple bands for association with a background region.

Regions
Functions in this section are for manually creating, deleting and moving regions. Regions are areas of interest to be analyzed outside the context of lanes. Regions are depicted in blue and designated as V1, V2, V3, etc. to denote volume 1, volume 2, volume 3, etc. Data measured in regions are located to the right of lane data in the Analysis Table.

Note Regions can be deleted by selection with the mouse and then pushing Delete on the keyboard.

Create rectangular region – Select this button and click a position on the image corresponding to a corner of the rectangle. Drag and release the mouse button to complete rectangle creation.

Create circular region – Select this button and click a position on the image corresponding to the edge of the circular region. Drag and release the mouse button to complete circular region creation.
Create freehand region – Select this button and click a position on the image corresponding to the edge of a region of interest. Drag the mouse along the edges of the region and release the mouse button to complete freehand region creation.

Move region – Select this button to click and drag a region to the optimal location.

Note Regions can be dragged to overlap with the lane frame, lanes, bands and other regions.

Activate region copy – To duplicate a region, first select the region to activate this button. Select Activate region copy and click a location on the image to paste the copied region. The region is pasted with the mouse click point as the center of the region.

Note After selecting this button, the mouse cursor includes a graphic of two overlapping rectangles to indicate the copy function is engaged.

Background Subtraction

ImageAnalysis Software performs automatic local background subtraction. The raw data and the local background corrected data are automatically displayed in the Analysis Table. Global and rolling ball background subtraction methods are available.

Local background subtraction – Local background subtraction is automatically performed by the program when a band or region is identified. The average pixel intensity of the border of each band or region is calculated as local background intensity and this value is subtracted from each pixel intensity within the band or region. This background subtraction method is used to generate Local Background Corrected Volume and Density values in the Analysis Table.

Global background subtraction – Global background subtraction designates a region as background to then be subtracted from volume regions or bands. There are two methods to activate global background subtraction: (1) select a background region and then associate with volume regions or (2) select volume regions or bands to then associate with a background region. Global background subtraction allows designation of multiple background regions for association with a subset of volume regions or bands on an image. For example, when analyzing an image with uneven background, it may be necessary to designate more than one background region for subtraction from certain volume regions or bands of interest.

Note For accurate global background correction, designate a background region that is equivalent in size (pixels) to the region of interest.
Scenario 1: Select a background region and then associate with volume regions.

1. Create a region (rectangular, circular or freehand).

2. Select the region by mouse click; this activates the Convert to Background Region button. Use this button to convert the volume region to a background region, changing the designation (e.g., from V1 to B1) and the color of the background region perimeter.

3. Select Associate with Volume Regions and Shift+click the regions to be associated with this background region.

   Note This workflow only associates volume regions with the background region. To associate bands with a background region, see Scenario 3: Selecting bands to then associate with a background region.

4. Select Done to accept the associations and the region and background boundaries change to a unique color indicating they are linked. Global Background Corrected Volume and Density values are available in the Analysis Table.

Scenario 2: Select volume regions to then associate with a background region.

1. Create a region (rectangular, circular or freehand). Select the region by mouse click; this activates the Convert to Background Region button. Use this button to convert the volume region to a background region, changing the designation (e.g., from V1 to B1) and the color of the background region perimeter.

2. Select a volume region by mouse click and select Associate with Background Region.

3. Select Done to accept the associations; the region and background boundaries change to a unique color indicating they are linked. Global Background Corrected Volume and Density values are available in the Analysis Table.

Scenario 3: Selecting bands to then associate with a background region.

1. Create a region (rectangular, circular or freehand). Select the region by mouse click; this activates the Convert to Background Region button. Use this button to convert the volume region to a background region, changing the designation (e.g., from V1 to B1), and the color of the background region perimeter.

2. Select Select multiple bands and click on different bands.

3. Select Associate Bands with Background Region and click the background region to be associated with these bands.

4. Select Done to accept the associations. The region and background boundaries change to a unique color indicating they are linked. Global Background Corrected Volume and Density values are available in the Analysis Table.
Use the Clear Associations button to clear the associations between volume and background regions. Click on the background region and then select Clear Associations to clear associations with all volume regions linked to that background. Click on a volume region and then select Clear Associations to clear the association with a background region for only the selected volume region. Alternatively, clicking a volume-associated background region and selecting Convert to Volume Region clears associations with all volume regions linked to that background. Clicking a background-associated volume region and selecting Convert to Background Region clears associations with this region.

Rolling Ball background subtraction – Rolling Ball background subtraction involves designating a radius for a hypothetical rolling ball that removes background along the length of the lane, where the radius of the rolling ball (1-99 pixels) determines how much background is subtracted. A ball with the designated radius is rolled beneath the intensity trace of the lane, forming a line located at the center of the ball. The background is then one radius length above this line where the height above background is the reported background corrected intensity. A large radius loosely follows the intensity trace of the lane, thereby removing less background. A line generated by a small radius closely follows the intensity trace of the lane, thereby removing more background. A radius that is too large results in poor background removal, while a radius that is too small may subtract intensity from the lane trace.

Note Rolling ball subtracted data appears in the Lane Profile view; however, the subtracted data does not appear on screen. Review the corrected lane trace in the Lane Profile while performing rolling ball subtraction to optimize the radius for the image.

Note Using a large rolling ball radius results in longer image processing time.

1. Check the Rolling Ball Subtraction box to activate this method of background correction.
2. The default radius is 50 pixels; the Analysis Table is updated to include Rolling Ball Background Corrected Volume and Density values.
3. To change the pixel radius of the rolling ball, click inside the Radius box and enter a radius between 1 and 99 pixels.
4. Select the Apply Radius checkmark and the Rolling Ball Background Corrected Volume and Density values in the Analysis Table will be updated.
The Marker Lanes box depicts the number of lanes created on an image. To assign a lane as a marker, click the lane in the Marker Lanes box. The lane number on the image is denoted as “Marker” under the lane frame. Multiple lanes can be designated as a marker; however, only one molecular weight marker identity can be used for analysis. The area under the Marker Lanes box displays the marker identity after the marker is chosen from the drop-down menu and Apply MW Markers has been selected.

Markers Drop-down Menu

The Markers drop-down menu contains preloaded molecular weight markers (both DNA and protein) that can be selected. Click on the arrow to access the full list and select the appropriate molecular weight marker for analysis.

Regression Drop-down Menu

The Regression drop-down menu contains five regression methods for calculating a standard curve used to determine molecular weight. Some of these regression methods provide an equation for the standard curve and an $R^2$ term (a measure of the quality of the overall curve fit to the data set).

Linear (semi-log) — This is the default regression method for determining molecular weight. The linear equation is $y = ax + b$, where $y$ is the molecular weight, $a$ is the slope of the line, $x$ is the relative front (R) and $b$ is the intercept. This linear equation is calculated with the log of the molecular weight values of the markers.

Note In some cases the calculated molecular weight varies from visual estimation of the molecular weight based on comparison to the two nearest markers. In such a case, changing to the point-to-point regression method results in calculated molecular weights consistent with visual estimation.
**Point To Point (semi-log)** – This regression method determines the slope of the line between two markers. Therefore, no single equation and no R² term are available for this method. The log of the molecular weight values of the markers is used to generate the slope between each pair of markers.

**Logistic** – This regression method uses a four parameter logistic equation to determine molecular weight. This method is best suited for data distributed as an S-shaped curve. The equation is $F(x) = [(a-d)/(1 + ((x/c)^b))] + d$, where $F(x)$ is the molecular weight, $x$ is the relative front ($R_f$), $a$ is the molecular weight at $R_f = 1$ (minimum asymptote), $b$ is the slope factor, $c$ is the inflection point, and $d$ is the molecular weight at $R_f = 0$ (maximum asymptote).

**Quadratic** – Quadratic regression is a form of multiple linear regression with the equation $y = ax^2 + bx + c$, where $y$ is molecular weight, $x$ is relative front ($R_f$) and $a$, $b$ and $c$ are coefficients determined by the least squares method to yield a quadratic curve that best fits the data set.

**Least Square** – This regression method determines molecular weight by a linear equation: $y = ax + b$, where $y$ is the molecular weight, $a$ is the slope of the line, $x$ is the relative front ($R_f$) and $b$ is the intercept. This linear equation is calculated with the log of the molecular weight values of the markers. This method minimizes the sum of squared differences between an observed value and the fitted value provided by a model.

### Apply MW Markers

The **Apply MW Markers** button activates molecular weight determination of all unknown bands using the bands in the marker lane identified in the **Marker Lanes** box, the molecular weight marker identified in the **Markers** drop-down menu, and the regression method selected in the **Regression** drop-down menu. Selecting this button engages the molecular weight determination process, resulting in horizontal molecular weight lines across the lane frame in the image and populating the molecular weight data in the **Analysis Table**. Select a lane of interest and then the **MW Curve** button on the **Right-hand Toolbar** to view the standard curve generated by the selected molecular weight marker and the interpolated molecular weight associated with the Rf of each band in the selected lane.
**Settings**

The **Settings** button allows manual addition of molecular weight markers to the **Markers** drop-down menu. Added molecular weight markers can then be used for molecular weight determination of bands on an image. Markers can be added and edited as follows or deleted using the red ❌ in the right-hand column of each row.

**Note** The preloaded **Markers** available in the drop-down menu cannot be edited or deleted.

---

**Add marker** — Select this button to add a new marker to the list. Enter the **Marker Name** to be listed in the drop-down menu; choose the **Type** (protein, DNA or RNA) and Unit (kDa, kb or bp) from the drop-down menus. Click **OK** to accept new marker entry or **Cancel** to delete marker entry.

---

**Edit marker** — Click on an editable marker from the list (editable markers have a red ❌ to activate the **Edit** button. Select this button to edit the marker name, type and/or unit. Click **OK** to accept edits or **Cancel** to return to the original information.

**Note** Preloaded markers cannot be edited; however, the information can be cloned as described below.
Clone marker – Click on a marker from the list to activate the Clone marker button. Select this button to make a copy of the selected marker that is denoted “Copy” in the name. Use the Edit marker button to change the marker name, type and/or unit, as necessary. All band label and value information is cloned and can be edited.

Selecting a marker in the list of the Settings window populates the band label and band value section of the window. This table lists all of the band information associated with the selected marker. Band labels and values can be added and edited as described below or deleted using the red x in the right-hand column of each row.

Add band – Select this button to add a new band to a marker. Enter the Band Label to be listed in the table and the Band Value to be used for molecular weight determination. Click OK to accept new band entry or Cancel to delete band entry. Bands populate the list in numerical order with the highest molecular weight at the top of the table.

Edit band – Select this button to edit a band from a marker. Enter the Band Label to be listed in the table and the Band Value to be used for molecular weight determination. Click OK to accept edits or Cancel to return to the original information.

Molecular Weight Marker Overlay
The proprietary molecular weight marker (MWM) overlay feature allows you to perform molecular weight determination using a colorimetric molecular weight marker in the corresponding chemiluminescent image. The image size, resolution and membrane location must be identical for this feature to function properly. Chemiluminescent images acquired from the myECL Imager include a visible image (ChemiV) of the membrane. When using this feature with images obtained from an alternate imager, both chemiluminescent and visible images need to be taken without moving the membrane between acquisitions.

1. Open chemiluminescent and visible images (Chemi and ChemiV image files from the myECL Imager).
2. Select the Image tab and adjust chemiluminescent image contrast with the White slider bar or Auto Adjust button until bands are visible.
   
   Note Image Flip, Rotate, Crop, and Invert are not compatible with the MWM Overlay feature.
3. In the Lanes/Bands subtab, manually add the appropriate number of lanes to the chemiluminescent image, including the lane that contains the colorimetric molecular weight marker.
4. Resize the lane frame to fit the imaged blot; adjust lane placement, width and/or skew as necessary.
5. In the **Molecular Weight** subtab, select the visible image file name in the **MWM Overlay** drop-down menu.

   **Note** For the **MWM Overlay** feature to function properly, the visible and chemiluminescent images must have opposite background designations in the **Auto-Analyze** module. If the visible image file does not appear in the drop-down menu, select the visible image from the **Image Bench** and reverse the image background designation in the **Auto-Analyze** module.

6. In the **Marker Lanes** box, select the lane containing the molecular weight marker.

7. In the **Markers** drop-down menu, select the appropriate molecular weight marker. In the **Regression** drop-down menu, select the appropriate regression method.

8. Select **Apply MW Markers**.

9. Check the **Find Bands** box in the **Auto-Analyze** module and select **Run**.

10. Adjust the band sensitivity detection level in the **Sensitivity** tool to identify all marker bands and bands of interest. Select **OK**.

   **Note** The sensitivity level may need to be 100% for all marker bands to be identified.

   Remove undesired bands in the chemiluminescent image with the **Delete bands** button in the **Lanes/Bands** subtab or by selecting the band and pushing **Delete** on the keyboard.

**Overlay Result**

The result is a display of the colorimetric molecular weight marker image within the chemiluminescent image. Molecular weight determination is performed for the located bands and results are displayed in the **Analysis Table**. Accurate densitometry analysis can be performed only on the chemiluminescent image. Pixel intensities in the marker lane on the **Analysis Table** are from the visible image; all other pixel intensities in the **Analysis Table** are from the chemiluminescent image.
The **Quantity** subtab contains tools for performing relative and absolute quantitation of bands. These functions are enabled when a band or region is selected on the image.

### Relative Reference

Assigning a band or volume region as a relative reference allows comparison of Local Background Corrected Volume of the reference area to all other bands and regions on the image. Performing this task normalizes all bands/regions to one band/region of interest. This is a useful tool for comparing experimental samples to a control (e.g., comparing siRNA knockdown sample to the control) where fold-change is interpreted by data normalization.

Click a band or volume region and select **Assign Relative Reference Region**. The Relative Quantity value in the **Analysis Table** for the relative reference region is “1,” and all other bands and volume regions have a proportional value reported in this column. Select **Clear** to disengage the relative reference assignment. Assignment of a volume region as a relative reference changes the region’s designation from V1 to Q1R (volume 1 to relative reference quantity 1).

**Note** Only one band or region can be assigned as a relative reference. Selection of another band or region and then **Relative Reference Region** results in a window requesting an override of the previous reference data.

### Absolute Reference

Assigning several bands or volume regions as absolute references with known quantities allows volume (sum pixel intensity) quantity interpolation/extrapolation for all other bands and regions on the image. This is a useful tool for determining amount of a sample when at least two known quantities of sample are on the same image.

1. Click a band or volume region and then select **Assign Absolute Reference Region**.
   
   Each band or region is assigned an “A” to designate that the band is now an absolute reference. The lane or Band/Region identifier appears in the Absolute Reference Table. A small pen  icon and a red  delete icon appear in the **Quantity Column** of the Absolute Reference Table.
2. Select the pen icon to enter or edit the numeric quantity for the band or region. Select the red delete icon to remove the band or region from the table.

3. Under the Units drop-down menu, select the unit of measure (milligram, microgram, nanogram, picogram, femtogram, nanomole, picomole, femtomole, milligram per milliliter or microgram per milliliter). Select the regression method appropriate for the data set from the Regression drop-down menu. Select Force through origin to create a quantity standard curve point at the graph origin.

4. The Quantity Curve, based on the regression method chosen, displays the absolute quantity value on the y-axis and the Local Background Corrected Volume on the x-axis and can be displayed by selecting the Lane or Region Quantity Curve buttons. If the absolute quantities were assigned to bands, then select the Lane Quantity Curve button to view the standard curve. If the absolute quantities were assigned to regions, then select the Region Quantity Curve button.

5. The calculated quantities for each of the non-quantity standard bands appear in the Analysis Table under the Absolute Quantity column. The units listed in the column are based on the quantity value assigned from the Units drop-down menu.
Chapter 5

Annotation Tab

Text Annotation

Create text — Select the Create text tool to add a text box to the image. Click anywhere on the image for the text box to appear; enter text. To add another line of text within the text box, click Shift+Enter or CTRL+Enter on the keyboard. Complete text entry by clicking outside of the text box on the image or push the Enter key on the keyboard. The text box automatically sizes to the size of the text; enlarge or shrink the text box by changing the font size and style.

Edit text — After creating a text box, click outside of the text box on the image or push Enter on the keyboard; double click the text box to activate text entry. The existing contents of the text box are highlighted and can be replaced by typing in text. Click the right or left arrow key on the keyboard to retain the current text and activate a cursor. Move the cursor to the correct location and enter or edit text.

Move and rotate text — After creating a text box, click outside of the text box on the image, push Enter on the keyboard and click and drag the text box to the appropriate location. The cursor appears as two perpendicular double-sided arrows when the text box can be moved. Rotate the text box by clicking and dragging the small white box that appears in the upper right corner of the text box. The cursor appears as two curved arrows when the text box can be rotated.

Font — Changed by selecting any font from the drop-down menu (Arial is the default font). Select the desired text box by clicking once and choose a font.
**Size** — Font size can be changed by selecting any size from the drop-down menu. Sizes range from 8 point to 72 point with a default setting of 16 point. Select the desired text box by clicking once and choose a font size.

**Style** — Font style can be changed with the icons **Bold**, **Italics**, **Underline** and **Strikethrough**. Select the desired text box by clicking once, then select a single icon or multiple icons to change the font style.

**Color** — Red is the default font color for text boxes. The font color can be changed to yellow, green, blue, black or white. Select the text box and select **Change Color of Annotation** (color palette appears); choose the desired color for each object.

**Line Annotation**

**Create line** — Select the **Create line** tool to add a line to the image. Click anywhere on the image to start the line and keep the mouse button pressed. Draw the line to the desired point and release mouse button.

**Move line** — Move a line by clicking on it and dragging to the appropriate location. The cursor appears as two perpendicular double-sided arrows when the line can be moved.

**Adjust and rotate line** — Select the line by clicking on it. The cursor appears as two perpendicular double-sided arrows when the line can be selected. Adjust the line length or rotate the line by clicking and dragging one of the small white boxes that appear at the ends of the line. The cursor appears as two curved arrows when the line can be adjusted or rotated.

**Stroke Width** — The thickness of a line can be changed by increasing or decreasing **Stroke Width**. Select a line and use the up and down arrows to choose the desired width; changes are made in real-time to the selected object. Stroke widths range from 1 point to 100 point with a default setting of 1 point.

**Color** — Red is the default color for lines. The line color can be changed to yellow, green, blue, black or white. Select the line and then select **Change Color of Annotation** (color palette appears); choose the desired color for each object.
**Arrow Annotation**

**Create arrow** – Select the Create arrow tool to add an arrow to the image. Click anywhere on the image to start the arrow and keep the mouse button pressed. Draw the arrow to the desired point and release the mouse button.

**Move arrow** – Move an arrow by clicking on it and dragging to the appropriate location. The cursor appears as two perpendicular double-sided arrows when the arrow can be moved.

**Adjust and rotate arrow** – Select an arrow by clicking on it. The cursor appears as two perpendicular double-sided arrows when the arrow can be selected. Adjust arrow length or rotate the arrow by clicking and dragging one of the small white boxes that appear at the ends of the line. The cursor appears as two curved arrows when the arrow can be adjusted or rotated.

**Stroke Width** – The thickness of an arrow can be changed by increasing or decreasing Stroke Width. Select an arrow and use the up and down arrows to choose the desired width; changes are made in real-time to the selected object. Stroke widths range from 1 point to 100 point with a default setting of 1 point.

**Arrow Style** – Use the Arrow Style function to change the style of the arrowhead. Select an arrow and choose an arrow style in the drop-down menu.

**Color** – Red is the default color for arrows. The arrow color can be changed to yellow, green, blue, black or white. Select the arrow and select Change Color of Annotation (color palette appears); choose the desired color for each object.

**Align Annotations**

Align left  
Align center  
Align right  
Align top  
Align bottom

The Align tools can be used to align text boxes, lines or arrows when multiple objects are selected. Options include Align left, Align center and Align right for vertical alignment and Align top, Align center and Align bottom for horizontal alignment.

**Note** The Align tools are active only when multiple objects are selected. Use Shift+Click or CTRL+Click to select multiple annotation objects; then select one of the alignment tools to align the objects as desired.
Chapter 6

Right-hand Toolbar

Right-hand Toolbar – Image Display Functions

The Right-hand Toolbar contains functions used for image display, image generation and template creation as well as buttons for display of the Lane Profile and molecular weight standard curve. All of these toolbar functions are always available.

Hand Tool — The hand tool can be used to “grab” and move the image.
**Fit Image to Screen** — Images that do not entirely fit in the **Main Image View** can be scaled to fit using this function. **Fit Image to Screen** can also be used to undo any image resizing done using the **Zoom In** and **Zoom Out** functions.

**Zoom In/Zoom Out** — Select these functions to increase or reduce the size of the image in the **Main Image View**.

**Black/White/Gamma** slider bars — See **Contrast Adjustment**.

**Show/Hide Image** — Hides the image from the **Main Image View** in order to visualize the lanes, bands, annotations or regions.

**Show/Hide Lanes, Bands and Regions** — Hides any lanes, bands or regions on an image. This function does not remove the lanes, bands or regions.

**Show/Hide Annotations** — Hides annotations that have been added to an image. This function does not remove the annotations.

**Cursor status** — Displays real-time x- and y-coordinates and the pixel intensity for the corresponding cursor location.

**Image Rotation Angle** — Displays the rotation angle applied to the image.

---

**Right-hand Toolbar — Template Creation**

Image analysis templates can be created using functions located in the **Right-hand Toolbar**. Templates are files that contain grouped objects, such as the lane frame, regions and annotations.

**Object selection tool** — Selects objects to be included in a template.

**Note** Once the **Object selection tool** has been activated, the functions located in the **Lanes/Bands** and **Annotation** tabs become disabled. The **Object selection tool** is not used to edit objects such as the lane frame, lane or regions. To edit an object, disable the **Object selection tool** and then select the object with the cursor.

To select an individual object, activate the **Object selection tool** and click on the object. The object turns gray to show that the object has been selected. To select multiple objects, use **Shift+Click**.

**Select all objects for template** — Selects all objects in the **Main Image View**.
Save to template — This function becomes active when one or more objects have been selected using the Object selection tool or Select all objects for template. Templates can then be saved by selecting Save to template. Selecting Save to template creates a template file with an .iat extension (image analysis template) that can be named and saved to a desired location. When no objects have been selected or a template is not currently in use, the Save to template feature is disabled and replaced with the Import template feature.

Creating Templates — Copy/Paste Feature

Copy  Paste

Templates or groups of objects can be copied and pasted by using the copy/paste feature. Any object or objects(s) can be selected with the Object selection tool and then copied to the clipboard by using either CRTL+C or selecting the Copy to clipboard. The objects in the clipboard can be pasted onto the image by using CRTL+V or the Paste from clipboard function.

Using Templates

To begin using a saved template:

1. Open an image and perform image adjustments.
2. Select Import template from the Right-hand Toolbar. Select the .iat file from its saved location and select Open. Objects in the template appear over the image. Any regions or bands included in the template measure the underlying pixel intensities and display the results in the Analysis Table.
3. If the template needs to be moved to better fit the contents of the image, use the Select all objects for template feature. All objects in the template are selected and highlighted, which can then be moved up, down, left and right over the image by using the arrow keys on the keyboard.

   Note Templates containing a lane frame with created bands lose the band information when the template is moved. New bands need to be added manually or automatically using the Auto-Analyze feature with only Find Bands selected.

   Note Import template is available only for images that do not previously contain any objects, such as regions, lanes or bands.

Individual objects or groups of objects in the template can be selected and moved by using the Object selection tool along with the keyboard arrow keys. To move objects, first select objects to be moved and deselect objects that are not to be moved. Any object selected in the template can be moved with the keyboard arrow keys.
Undo/Redo

Undo or Redo can be performed by selecting the Undo and Redo arrows. The keyboard shortcuts CTRL+Z (Undo) and CTRL+Y (Redo) can also be used.

Lane Profile

Lane Profile is a tool to visualize the pixel intensity cross section of an entire lane. A graph of \( R_f \) vs. Intensity is generated when at least one lane and one band are defined on an image. To view the Lane Profile, select the Lane Profile button on the Right-hand Toolbar.

Zoom In/Out — Select Zoom In/Out to change the size of the lane profile.

Lane selection menu — Selects which lane is viewed in the Lane Profile window. Lanes can be selected using the drop-down menu. Once a lane has been selected and the selection menu turns blue, the lanes can be scrolled with the up and down arrow keys on the keyboard. Selecting any lane or band from the Main Image View also displays the selected lane in the Lane Profile.

\( R_f \) value — The \( R_f \) value of the cursor location within the lane is displayed.

Intensity — The intensity of the pixel is measured where the cursor is located.

Lane view — Displays the original image along with any created bands. In the Lane view, the top and bottom boundaries of the band can be adjusted by selecting and moving the red band boundaries.

Lane profile view — Displays a cross-section of each lane’s pixel intensity. The pixel intensity is graphed on the horizontal axis against the \( R_f \) on the vertical axis. Each band is labeled with its corresponding band number. The light blue color designates the area of pixel intensity that corresponds to each band. Band area can be refined by selecting and moving the red band boundaries in the Lane view.
Molecular Weight Standard Curve

The MW Curve function displays the molecular weight standard curves created using the Molecular Weight subtab function under the Lanes/Bands tab. MW Curve is active only after a molecular weight marker has been applied to a lane on the image. Select the molecular weight marker lane and then the MW Curve button on the Right-hand Toolbar to view the standard curve. The MW Curve button displays a graph of the Rf vs. the molecular weight of each band in the molecular weight marker lane. The purple line denotes the curve generated by the selected regression method. The green circles are the individual standard values applied to the regression method to create the standard curve. The red circles indicate the calculated molecular weight of all other non-molecular weight standard bands in the selected lane.

Log Y-Axis – Toggles log transformation of the y-axis.

Regression Method – Displays the selected regression method.

Formula – Displays the equation obtained from the regression method.

R-squared Value – Displays the R^2 value, or “goodness of fit,” for the chosen regression method.

The results for each lane can be viewed in the standard curve window by selecting the individual lane shown in the Main Image View.
Chapter 7

Analysis Table

All image analysis data is displayed real time in the **Analysis Table**.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>46270724</td>
<td>184</td>
<td>32755.56</td>
<td>32260</td>
<td>489513</td>
<td>21793.43</td>
<td>N/A</td>
<td>31890.89</td>
<td>N/A</td>
</tr>
<tr>
<td>2</td>
<td>64270820</td>
<td>184</td>
<td>32755.56</td>
<td>32260</td>
<td>489513</td>
<td>21793.43</td>
<td>N/A</td>
<td>31890.89</td>
<td>N/A</td>
</tr>
<tr>
<td>3</td>
<td>46270724</td>
<td>184</td>
<td>32755.56</td>
<td>32260</td>
<td>489513</td>
<td>21793.43</td>
<td>N/A</td>
<td>31890.89</td>
<td>N/A</td>
</tr>
<tr>
<td>4</td>
<td>46270724</td>
<td>184</td>
<td>32755.56</td>
<td>32260</td>
<td>489513</td>
<td>21793.43</td>
<td>N/A</td>
<td>31890.89</td>
<td>N/A</td>
</tr>
<tr>
<td>5</td>
<td>46270724</td>
<td>184</td>
<td>32755.56</td>
<td>32260</td>
<td>489513</td>
<td>21793.43</td>
<td>N/A</td>
<td>31890.89</td>
<td>N/A</td>
</tr>
<tr>
<td>6</td>
<td>46270724</td>
<td>184</td>
<td>32755.56</td>
<td>32260</td>
<td>489513</td>
<td>21793.43</td>
<td>N/A</td>
<td>31890.89</td>
<td>N/A</td>
</tr>
</tbody>
</table>

View the **Analysis Table** for opened images by selecting the **double up arrows** on the lower right-hand section of the application window.

Once analysis objects, such as lanes, bands or regions are created, the analysis table is populated with image data. The layout of the analysis table is divided into either Region ID, which lists the analysis information for each created Region, or by Lane, which lists the analysis information for each lane identified in each lane.

The **Analysis Table** data scrolls horizontally to accommodate each lane. Selecting a lane on the image displays the selected lane’s analysis data. Selecting an individual band displays the appropriate lane and highlights in blue the band analysis in the **Analysis Table**.
The **Analysis Table** contains the following fields:

- **Region ID** – Identifies the number of defined regions.

- **Region Label** – Identifies each region as either a volume region (V), background region (B), quantity relative reference region (QR) or quantity absolute region (QA). Each region also contains a number based on the order in which they were created (e.g., volume region V1, background region B2, quantity absolute reference region Q3A or quantity relative region Q4R).

- **Lane and Band Number** – Each lane and band in each lane are identified by a number.

- **Volume** – Equals the sum of each pixel grayscale intensity in the region or the band. The units of Volume are intensity. All pixel (8-bit, 12-bit or 16-bit) intensities are displayed as they would be for a 16-bit image; 8-bit or 12-bit pixel images are multiplied by a constant that is then used to calculate the pixel volume.

- **Area** – The number of pixels within each region or band.

- **Density** – The average intensity per pixel or Volume divided by Area with units of Intensity/Area.

- **Median** – The statistical median pixel intensity.

- **Local Bkg. Corr. Volume** – Local Background Corrected Volume is defined as Volume minus the local background intensity. This value is automatically calculated for each band or region and cannot be disabled (see Local Background Subtraction).

- **Local Bkg. Corr. Density** – Local Background Corrected Density is defined as the Local Background Corrected Volume divided by the Area (see Local Background Subtraction).

- **Global Bkg. Corr. Volume** – Global Background Corrected Volume is defined as the Volume minus the global background defined area intensity (see Global Background Subtraction).

- **Global Bkg. Corr. Density** – Global Background Corrected Density is defined as Global Background Corrected Volume divided by the Area (see Global Background Subtraction).

- **Rolling Ball Bkg. Corr. Volume** – Rolling Ball Background Corrected Volume is defined as the Volume minus the rolling ball background subtraction value (see Rolling Ball Subtraction).

- **Rolling Ball Bkg. Corr. Density** – Rolling Ball Background Corrected Density is defined as the Rolling Ball Background Corrected Volume divided by the Area (see Rolling Ball Subtraction).

- **Relative front (R)** – A number between 0 and 1 describing the distance a band has migrated divided by the total length of the lane.

- **Molecular Weight (MW)** – Calculated molecular weight of the band based on the molecular weight Standard Curve (MW Curve). The asterisk (*) changes to the mass unit based on the type of molecular weight standard used. Units are in kDa (kilodaltons), bp (base pairs) or kbp (kilobase pairs).

- **Relative Quantity** – Ratio of the region or band volume divided by the relative reference region or band volume (see Relative Reference).
**Absolute Quantity** – Quantity value obtained from the Quantity Curve. The asterisk (*) changes to the mass unit selected from the Units drop-down menu in the Quantity subtab (see Absolute Reference).

**% Purity** – A region’s volume divided by the volume of all regions in the image multiplied by 100. If rolling ball subtraction has been engaged, then % Purity is the region’s rolling ball background corrected volume divided by the rolling ball background corrected volume of all regions in the image multiplied by 100.

**% Purity (Band)** – A band’s local background corrected volume divided by the local background corrected volume of all bands in the lane multiplied by 100. If rolling ball subtraction has been engaged, then the % Purity (Band) is the band’s rolling ball background corrected volume divided by the rolling ball background corrected volume of all bands in the lane multiplied by 100.

**% Purity (Lane)** – A band’s volume divided by the volume of the entire lane multiplied by 100. If rolling ball subtraction is engaged, then the % Purity (Lane) is the band’s rolling ball background corrected volume divided by the rolling ball background corrected volume of the entire lane.
Chapter 8

Troubleshooting

Technical Support

If you have a technical question that you are unable to answer after consulting the documentation, please contact our Technical Support team.

Thermo Fisher Scientific
3747 North Meridian Road
Rockford, Illinois USA 61101
U.S. Toll-free: (800) 874-3723
Main: +1 (815) 968-0747
Fax: (800) 842-5007
E-mail: pierce.ts@thermofisher.com

FAQs

Images

Q: When I open my Chemi image, all I see is black. Why can’t I see my bands?
A: The Chemi image has low intensity bands or pixels. Select Auto Contrast in the Image tab to see the spots or bands.

Q: What image types are compatible with mvImageAnalysis Software?
A: TIFF, JPEG, PNG, GIF and BMP files < 800 ppi are compatible. See Table 2-1 in the Image Compatibility section of the manual for detailed image compatibility information.

Q: Why do the contrast adjustment values not match the pixel intensities?
A: The values listed as the maximum values in the contrast adjustment reflect the image type. Eight-bit (2^8) images have a maximum pixel intensity of 256, 12-bit (2^12) images have a maximum pixel intensity of 4,096, and 16-bit (2^16) images have a maximum pixel intensity of 65,536. The pixel intensities are reported as if the pixels were from a 16-bit image. Therefore, 8- and 12-bit pixel intensities are multiplied by a constant to scale the intensities to a 16-bit image. This allows for direct comparison of images with different digital pixel information.
Q: Why can’t images from the mECL Imager or images saved from mImageAnalysis Software be viewed in the Windows picture viewer, Microsoft Paint or added into PowerPoint or Word files?
A: Images from the mECL Imager or images saved in mImageAnalysis Software contain embedded non-pixel information, such as image acquisition information and annotations. Windows picture viewer and Microsoft Office programs are not compatible with these types of images. To copy mECL Imager images to other programs, open the image file in mImageAnalysis Software and press CTRL+C on the keyboard. This copies the displayed image to the clipboard, which can then be pasted into another program by pressing CTRL+V. Alternatively use the Export Image to PowerPoint, Word or JPEG/TIFF features in the File tab of mImageAnalysis Software. Images from the mECL Imager and mImageAnalysis Software can be opened in Adobe Photoshop™ applications.

Molecular Weight
Q: How do I use the molecular weight overlay feature if there are no suitable images listed in the MWM Overlay drop-down menu?
A: To use the molecular weight overlay feature, the following requirements must be met:
1. The ChemiV image needs to be designated as dark objects on a white background. In the Lanes/Bands tab, change the background indicator in the Auto-Analyze module to dark objects on a white background.
2. The Chemi image needs to be designated as light objects on a black background. In the Lanes/Bands tab, ensure the background indicator in the Auto-Analyze module indicates white objects on a black background.

If these requirements have been met, then the ChemiV image should be available in the MWM Overlay drop-down menu.

User interface
Q: Why aren’t any of the buttons in the tabs active?
A: Either no image has been opened in the program or the Object selection tool in the Right-hand Toolbar has been selected. De-select the Object selection tool and the function buttons should become active.

Q: Why can’t I edit my annotations?
A: Annotations can be edited only while in the Annotations tab.

Q: How do I increase the lane size of a lane that is at the outermost portion of the image if the lane frame is preventing it?
A: Move the lane away from the lane frame, increase the lane size and then move the lane back to the desired location.
Q: Why can’t I overwrite a current file when I am trying to export an Image Report to PowerPoint or Word Software?
A: The export feature requires a different file name for each file. Please rename the file and try again.

Auto-Analysis

Q: Why is the background being identified as a band while the bands are being identified as background when I selected Find Lane, Find Bands and Run in the Auto-Analyze module to find lanes and bands?
A: Confirm the background designation is set appropriately for the image type, such as detection of black objects on a light background or light objects on a black background.

Q: Auto-analysis does not identify lanes well on a chemiluminescent image. What can I do to get the results I want?
A: Creating an Analysis Frame often improves the quality of the auto-analysis results. This is particularly true for chemiluminescent images because they typically contain few high intensity pixels.

Q: I am using Microsoft Office 2003, which is not compatible for the Export to PowerPoint feature. What can I do?
A: Microsoft offers a Microsoft Office compatibility pack that can be found here: http://www.microsoft.com/enus/download/details.aspx?id=3
This compatibility pack allows older versions of Office to open, edit and save documents, workbooks and presentations that were created in the newer versions of Word, Excel and PowerPoint Software.

Error Messages

- Minimal Lane Frame size is 10 × 10 pixels.
  The Analysis Frame needs to be larger than 10 × 10 pixels. Select Analysis Frame and redraw the area for analysis.
- File corrupted!
An incompatible file type has been used; please see Table 2-1 for compatible file types.
Appendix A

Getting Started

This section covers simple workflows to get started with miImageAnalysis Software. The purpose is to perform basic adjustment and analysis techniques, simply annotate the image, and obtain a report of the information generated. For a more in-depth description of software functions please consult chapters 1-7.

Example Workflow: Analyzing an Image to Assess Quantity and Purity of Bands in a Sample

Open Image

Select the Open Image button under the File tab to select an image for analysis. In the Open window, select the location and the image file type to open.

Adjust Image

1. Select the Image tab to show image adjustment tools.
2. Flip, Rotate or Crop the image as desired by selecting buttons in the top left of the screen.
3. Adjust the Black, White or Gamma contrast using the slider bars in the upper central region of the screen.
Assign Frame, Lanes and Bands

Automatic Detection of Frame, Lanes and Bands

1. Select the Lanes/Bands tab to show tools available.

2. For automatic detection of lanes and bands, check the Find Lanes and Find Bands boxes in the Auto-Analyze module and select Run.
   
   **Note** To specify a region for analysis, select the Analysis Frame button. Click and drag to create an Analysis Frame, which is depicted as a yellow box. An analysis frame is not required; however, designation of an analysis frame may improve auto-analysis results. For optimal results with chemiluminescent images, create an Analysis Frame. To redraw the analysis frame, select the Analysis Frame button and create a new one.

3. Select the Low, Medium or High button or drag the slider to the desired band detection sensitivity so that genuine bands are outlined but artifacts or background signal are not. Select OK.
   
   **Note** If an analysis frame was used, it appears yellow. The identified lane frame is orange.

Manual Selection of Frame, Lanes and Bands

1. Select the Lanes/Bands tab to show tools available.

2. To manually specify a frame for analysis, select Analysis Frame in the Auto-Analyze module and draw a box around the desired area of the image.

3. To specify lanes within the frame, manually count the number of lanes in the image; in the Lanes region of the function ribbon click on the up arrow until the correct number of lanes is shown. Click Go. The lanes appear inside the frame border.
Modification of Lane Frame, Lanes and Bands

Note To adjust the size or shape of a lane frame, lane or band for analysis, do not try to click on it and move or drag the edges. Use the tools in the function ribbon to activate adjustments.

Note To delete a lane frame and start over, simply draw a new frame in the desired place.

1. Adjust the lane frame using tools in the Lane Frame area of the function ribbon if necessary.
   a. Select the Move lane frame button and drag the frame to the desired position.
   b. Select the Resize lane frame button and drag the corners as appropriate.
   c. Select the Skew lane frame button and drag the corners as appropriate.

2. Adjust lanes using tools in the Lanes area of the function ribbon if necessary.
   a. Select the Delete lanes button and click on the lane to delete. Alternatively select a lane (turns blue) and push the Delete key on the keyboard.
   b. If lanes are incorrectly placed and require adjustment, use one of the following functions:
      i. Use the move lane function to move lanes laterally. Select the Move lane button and click on a lane, which turns blue. Drag the lane to the desired spot.
      ii. Use the resize lane function to adjust the lane width. Select the Resize lane button, and click on a lane, which turns blue. Drag the edges of the lanes as desired.
      iii. Use the skew lane function to edit individual lanes that are angled differently from those in the image. Select the Skew lane button, position the cursor over one of the white handles appearing in the lane, and drag until the lane is in the correct position.
      iv. Use the smiling correction function to edit lanes on images that have a “smiley face” appearance. Select the Smiling correction button, position the cursor over one of the white handles appearing at the top or bottom of the lane frame and drag until the lane frame is in the correct position. Manually adjust individual lanes if necessary.

3. Adjust bands using tools in the Bands area of the function ribbon if necessary.
   a. If extra or incorrect bands are shown, select the Delete bands button and click on the band to delete. Alternatively, select a band (turns yellow) and push the Delete key on the keyboard.
   b. If bands are incorrectly placed and require adjustment, use one of the following functions:
      i. Use the move bands function to allow vertical movement of a band within a lane. Select the Move bands button, click on a band (turns yellow). Drag the band to the desired spot.
      ii. Use the resize bands function to allow vertical resizing of a band within a lane. Select the Resize bands button, click on a band (turns yellow). Drag the white handles on the top and bottom edges of the band as desired.
Annotation

Multiple options exist for annotating an image. Select any of the following functions to add text, lines or arrows to an image.

1. The **Annotation** tab includes Create text, Create line and Create arrow tools.
   a. Select the Create text tool to add a text box on to the image. Click anywhere on the image for the text box to appear and type in text as desired. The text box can be rotated by dragging the small arrows that appear in the upper right corner of the text box. The text box automatically sizes to the text size.
   b. Select the Create line or Create arrow tools to add a line or arrow to the image. Click anywhere on the image to start, keep the mouse button pressed and draw to the desired point. The position of the line or arrow can be modified by dragging the small white boxes that appear at the start and end of the line or arrow.
   c. The thickness of the line or arrow can be altered using the Stroke Width tool. The arrowhead style can be altered using the Arrow Style tool.
   d. The font style can be changed by first selecting the text box and then selecting a Font from the drop-down menu. The font size can be adjusted by selecting Size from the drop-down menu.
   e. Text, line and arrow annotations can be aligned using the align tools. Select the desired objects for alignment by Shift+click. Options include Align left, center and right for horizontal alignment and Align top, center and bottom for vertical alignment. Align tools are available only when multiple objects are selected.

Comparing Band Intensity

To compare band intensity, reveal the **Analysis Table** by selecting the double up arrows button in the lower right corner.

Bands are listed in the first column for lane 1. Data scrolls horizontally to accommodate each lane. Multiple statistics are provided for each band.
**Image Report Export**

Image reports can be generated using the **Show Report** button in the **File** tab, which also allows for export of the analysis data to Word, PowerPoint or Excel Software as well as PDF format.

1. Select **Show Report** under the **File** tab.
   
   a. Select either the Microsoft PowerPoint, Microsoft Word or PDF icon.

   **Note** Adobe Reader Software must be installed in order to view created PDF files.

   b. For export to Excel Software, select the **Export Analysis** button.

   **Note** Export to Excel Software does not export the image or image information.

2. Selecting any of these options opens a **Save As** window. Select the save location for the file and type a file name.

3. Select **OK** and the Word, PowerPoint, Excel or PDF file is automatically opened and saved in the chosen location.

4. The appropriate application automatically opens and displays the created file.

**Print Report**

After the Image Report is generated, the report may be printed by selecting the **Print Report** button or **CTRL+P**.

Selecting **Print Report** opens a **Print Preview** window where print options are available.